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Unit –I 
 

Computer Fundamentals: Meaning, Features of Computers, Advantages and 

Limitations of Computer, Classification of Computers. Components of Computer : 

Input Unit, output Unit and CPU. Memory and storage: Primary Memory 

&Secondary memory, Input devices, output devices. Operating System- Meaning and 

functions Computer Software: Types of Software, Application software and system 

software 

Introduction to Windows Operating System: Directory Manipulation: Creating 

Directory, Sub Directory, Renaming, Coping and Deleting the Directory. File 

Manipulation: Creating a File, Deleting, Coping, renaming a file. 

 

Unit –II 
 

MS-Word: History, Creating, Saving, Opening, Importing, Exporting and Inserting 

document, Formatting pages, Alignment, Paragraphs and Sections, creating lists and 

numberings Formatting Commands: Headings, Styles, Fonts and Size editing,  

Viewing Text, Finding and Replacing text, Headers and Footers, Inserting page 

breaks, Page numbers, mail merge. MS-PowerPoint: History, Creating, Saving, 

Opening, existing presentation, Creating and Saving a Presentation using Auto 

Content Wizard, Design Template, Blank Presentation the Slide Sorter View, Slide 

Show, Inserting pictures and graphics and Printing Slides. 

 

Unit III 
 

MS-Excel: Introduction, Components of Excel History, Creating, Saving, Opening, 

Spreadsheet, Formatting numbers and Text, Graph and Chart Formatting Commands, 

Menu Bar, Toolbars, Producing Charges, Protecting Cell Macro and Printing 

Operation, Spell Checking, Cell Editing, Calculation of various Financial and 

Statistical Functions using Formulas. 

 

Unit IV 

Introduction to E- commerce : Meaning and concept – E- commerce v/s Traditional 

Commerce- E- Business, features & benefits of E- Commerce – Impacts, Challenges & 

Limitations of E-Commerce , Website – components of website – Concept & 

Designing website for E- Commerce – Corporate Website – Portal – Search Engine – 



 
 

Internet Advertising – Emergence of the internet as a competitive advertising media, 

Electronic Payment system, Security Issues in E-Commerce. 

 

Unit-1 
                               Meaning of Computer 

 

A programmable electronic device designed to accept data, perform 

prescribed mathematical and logical operations at high speed, and 

display the results of these operations. Mainframes, desktop and laptop 

computers, tablets, and smart phones are some of the different types of 

computers. 

 

 

Features  of Computer 

The characteristics of the computer system are as follows − 

 



Speed 

A computer works with much higher speed and accuracy compared to 

humans while performing mathematical calculations. Computers can 

process millions (1,000,000) of instructions per second. The time taken 

by computers for their operations is microseconds and nanoseconds. 

Accuracy 

Computers perform calculations with 100% accuracy. Errors may occur 

due to data inconsistency or inaccuracy. 

Diligence 

A computer can perform millions of tasks or calculations with the same 

consistency and accuracy. It doesn’t feel any fatigue or lack of 

concentration. Its memory also makes it superior to that of human 

beings. 

Versatility 

Versatility refers to the capability of a computer to perform different 

kinds of works with same accuracy and efficiency. 

Reliability 

A computer is reliable as it gives consistent result for similar set of data 

i.e., if we give same set of input any number of times, we will get the 

same result. 

Automation 

Computer performs all the tasks automatically i.e. it performs tasks 

without manual intervention. 

Memory 

A computer has built-in memory called primary memory where it stores 

data. Secondary storage are removable devices such as CDs, pen drives, 

etc., which are also used to store data. 

 



Advantages of computer 

Multitasking 

Multitasking is one of the major advantage of computer. Person can 

perform multiple task, multiple operation, calculate numerical problems 

within few seconds. Computer can perform trillion of instructions per 

second. 

Speed 

Now computer is not just a calculating device. Now a day’s computer 

has very important role in human life. One of the main advantages of 

computer is its incredible speed, which helps human to complete their 

task in few seconds. All the operations can be performed very fast just 

because of its speed else wise it takes a long time to perform the task. 

Cost/ Stores huge amount of data 

It is a low cost solution. Person can save huge data within a low budget. 

Centralized database of storing information is the major advantage that 

can reduce cost. 

Accuracy 

One of the root advantage of computer is that can perform not only 

calculations but also with accuracy. 

Data Security 

Protecting digital data is known as data security. Computer provide 

security from destructive forces and from unwanted action from 

unauthorized users like cyberattack or access attack. 

Disadvantage of Computer 

As we know advantage comes with disadvantage. 

Virus and hacking attacks 

Virus is a worm and hacking is simply an unauthorized access over 

computer for some illicit purpose. Virus is being transferred from email 

attachment, viewing an infected website advertisement, through 

removable device like USB etc. once virus is transferred in host 

computer it can infect file, overwrite the file etc. 

https://ecomputernotes.com/fundamental/what-is-a-database/advantages-and-disadvantages-of-dbms
https://ecomputernotes.com/fundamental/information-technology/what-do-you-mean-by-data-and-information


For example: Huge portion of internet was going down including 

Twitter, Netflix, Reddit and CNN in October 2016 because the largest 

DDoS attack was launched on service provider DYN using IoT Botnet. 

Online Cyber Crimes 

Online cyber-crime means computer and network may have used in 

order to commit crime. Cyberstalking and Identity theft are the points 

which comes under online cyber-crimes. For example: one may get the 

access of the access to your shopping account like amazon account now 

that person will be able to know your personal details like debit card or 

credit card number which can be than misused. 

 

Reduction in employment opportunity 

 

Mainly past generation was not used of the computer or they have the 

knowledge of computer they faced a big problem when computer came 

in field. As we have seen in banking sector senior bank employees faced 

this problem when computer came to the banking sector. 

 

 

Computer System Components 

Computer systems consist of three components as shown in below 

image: Central Processing Unit, Input devices and Output devices. 
Input devices provide data input to processor, which processes data and 

generates useful information that’s displayed to the user through output 

devices. This is stored in computer’s memory. 

https://ecomputernotes.com/computernetworkingnotes/services-and-applications/what-is-internet


 

Central Processing Unit 

The Central Processing Unit (CPU) is called "the brain of computer" as 
it controls operation of all parts of computer. It consists of two 

components: Arithmetic Logic Unit (ALU), and Control Unit. 

 

Arithmetic Logic Unit (ALU) 

Data entered into computer is sent to RAM, from where it is then sent 
to ALU, where rest of data processing takes place. All types of 

processing, such as comparisons, decision-making and processing of 



non-numeric information takes place here and once again data is moved 

to RAM. 

Control Unit 

As name indicates, this part of CPU extracts instructions, performs 

execution, maintains and directs operations of entire system. 

Functions of Control Unit 

Control unit performs following functions − 

 It controls all activities of computer 

 Supervises flow of data within CPU 

 Directs flow of data within CPU 

 Transfers data to Arithmetic and Logic Unit 

 Transfers results to memory 

 Fetches results from memory to output devices 

Memory Unit 

This is unit in which data and instructions given to computer as well as 

results given by computer are stored. Unit of memory is "Byte". 

 

 

Classification of Computer 

 

Computer scan is broadly classified by their speed and computing 

power. 

Sr.No. Type Specifications 

1 PC 

(Personal 

Computer) 

or Micro-

It is a single 

user computer 

system having 

a moderately 

powerful 



Sr.No. Type Specifications 

Computers microprocessor. 

It is termed as a 

computer that 

is equipped 

microprocessor 

as its CPU. 

2 Workstation It is also a 

single user 

computer 

system, similar 

to the personal 

computer, 

however, has a 

more powerful 

microprocessor. 

3 Mini-

Computer 

It is a multi-

user computer 

system, capable 

of supporting 

hundreds of 

users 

simultaneously. 

4 Main Frame It is a multi-

user computer 

system, capable 

of supporting 

hundreds of 

users 



Sr.No. Type Specifications 

simultaneously. 

Software 

technology is 

different from 

minicomputer. 

5 Super-

Computer 

It is an 

extremely fast 

computer, 

which can 

execute 

hundreds of 

millions of 

instructions per 

second. 

 

 

 

PC (Personal Computer) 

 

 

A PC can be defined as a small, relatively 

inexpensive computer designed for an individual user. PCs are based on 



the microprocessor technology that enables manufacturers to put an 

entire CPU on one chip. Businesses use personal computers for word 

processing, accounting, desktop publishing, and for running spreadsheet 

and database management applications. At home, the most popular use 

for personal computers is playing games and surfing the Internet. 

Although personal computers are designed as single-user systems, these 

systems are normally linked together to form a network. In terms of 

power, nowadays high-end models of the Macintosh and PC offer the 

same computing power and graphics capability as low-end workstations 

by Sun Microsystems, Hewlett-Packard, and Dell. 

Workstation 

 

The workstation is a computer used for engineering applications 

(CAD/CAM), desktop publishing, software development, and other such 

types of applications which require a moderate amount of computing 

power and relatively high-quality graphics capabilities. 

Workstations generally come with a large, high-resolution graphics 

screen, a large amount of RAM, inbuilt network support, and a graphical 

user interface. Most workstations also have mass storage device such as 

a disk drive, but a special type of workstation, called diskless 

workstations, comes without a disk drive. 

Common operating systems for workstations are UNIX and Windows 

NT. Like PC, workstations are also single-user computers like PC but 

are typically linked together to form a local area network, although they 

can also be used as stand-alone systems. 



Minicomputer 

It is a midsize multi-processing system capable of supporting up to 250 

users simultaneously. 

 

Mainframe 

The mainframe is very large in size and is an expensive computer 

capable of supporting hundreds or even thousands of users 

simultaneously. Mainframe executes many programs concurrently and 

supports much simultaneous execution of programs. 

 

Supercomputer 

Supercomputers are one of the fastest computers currently available. 

Supercomputers are very expensive and are employed for specialized 

applications that require an immense amount of mathematical 

calculations (number-crunching). 



 

For example, weather forecasting, scientific simulations, 

(animated)graphics, fluid dynamic calculations, nuclear energy research, 

electronic design, and analysis of geological data (e.g. in petrochemical 

prospecting). 

 

 

What is Memory? 

Memory is very much like our brain as it is used to store data and 

instructions. Computer memory is the storage space where data is to be 

processed, and instructions needed for processing are stored. The 
memory is divided into a large number of smaller portions called the cell. 

Every cell/ location has a unique address and a size. 

Two types of memories are: 

 Primary Memory 

 Secondary Memory 

 

What is Primary Memory? 

Primary memory is the main memory of the computer system. Accessing 
data from primary memory is faster because it is an internal memory of 

the computer. The primary memory is most volatile which means data in 

primary memory does not exist if it is not saved when a power failure 

occurs. 

Two types of Primary Memory are: 



 RAM 

 ROM 

RAM (Random Access Memory) 

Random access memory which is also known as RAM is generally 

known as a main memory of the computer system. It is called temporary 

memory or cache memory. The information stored in this type of 
memory is lost when the power supply to the PC or laptop is switched 

off. 

ROM (Read Only Memory) 

It stands for Read Only Memory. ROM is a permanent type of memory. 
Its content is not lost when the power supply is switched off. The 

computer manufacturer decides the information of ROM, and it is 

permanently stored at the time of manufacturing which can not be 

overwritten by the user. 

What is Secondary Memory? 

All secondary storage devices which are capable of storing high volume 

data is referred to secondary memory. It's slower than primary memory. 

However, it can save a substantial amount of data, in the range of 
gigabytes to terabytes. This memory is also called backup storage or 

mass storage media. 

Types of Secondary memory 

Mass storage devices: 

The magnetic disk provides cheap storage and is used for both small and 

large computer systems. 

Two types of magnetic disks are: 

 Floppy disks 

 Hard disks 



Flash/SSD 

Solid State Drive provides a persistent flash memory. It's very fast 

compared to Hard Drives. Frequently found in Mobile phones, its 

rapidly being adopted in PC/Laptop/Mac. 

Optical drives: 

This secondary storage device is from which data is read and written 

with the help of lasers. Optical disks can hold data up to 185TB. 

Examples 

 CD 

 DVD 

 

 

 

 Floppy Disk: A floppy disk is a flexible disk with a magnetic 

coating on it. It is packaged inside a protective plastic envelope. 

These are one of the oldest type of portable storage devices that 

could store up to 1.44 MB of data but now they are not used due to 

very less memory storage. 

 

 Hard disk: A hard disk consists of one or more circular disks 

called platters which are mounted on a common spindle. Each 

surface of a platter is coated with a magnetic material MB,GB,TB.  

USB drives: 

It is one of the most popular types of secondary storage device available 

in the market. USB drives are removable, rewritable and are physically 

very small. The capacity of USB drives is also increasing significantly 

as today 1TB pen drive is also available in the market. 

 



 

Input devices 

 

Keyboard 

Keyboard is the most common and very popular input device which 
helps to input data to the computer. The layout of the keyboard is like 

that of traditional typewriter, although there are some additional keys 

provided for performing additional functions. 

 

Mouse 

Mouse is the most popular pointing device. It is a very famous cursor-

control device having a small palm size box with a round ball at its base, 
which senses the movement of the mouse and sends corresponding 

signals to the CPU when the mouse buttons are pressed. 

 

Joystick 

Joystick is also a pointing device, which is used to move the cursor 

position on a monitor screen. It is a stick having a spherical ball at its 
both lower and upper ends. The lower spherical ball moves in a socket. 

The joystick can be moved in all four directions. 

 

 



Light Pen 

Light pen is a pointing device similar to a pen. It is used to select a 

displayed menu item or to show objects on the monitor screen. It 

consists of a photocell and an optical system placed in a small tube. 

 

 

 

Track Ball 

Track ball is an input device that is mostly used in notebook or laptop 

computer, instead of a mouse. This is a ball which is half inserted and 

by moving fingers on the ball, the pointer can be moved. 

 

 

 

 

 

Scanner 

Scanner is an input device, which works more like a photocopy 

machine. It is used when some information is available on paper and it 



is to be transferred to the hard disk of the computer for further 

manipulation. 

 

 

Microphone 

Microphone is an input device to input sound that is then stored in a 

digital form. 

 

The microphone is used for various applications such as adding sound 

to a multimedia presentation or for mixing music. 

 

Bar Code Readers 

Bar Code Reader is a device used for reading bar coded data (data in the 

form of light and dark lines). Bar coded data is generally used in 



labelling goods, numbering the books, etc. It may be a handheld scanner 

or may be embedded in a stationary scanner. 

 

 

 

 

 

 

 

Output Devices 

 

Monitors 

Monitors, commonly called as Visual Display Unit (VDU), are the 

main output device of a computer. It forms images from tiny dots, 

called pixels that are arranged in a rectangular form. The sharpness of 

the image depends upon the number of pixels. 

There are two kinds of viewing screen used for monitors. 

 Cathode-Ray Tube (CRT) 

 Flat-Panel Display 

Cathode-Ray Tube (CRT) Monitor 

The CRT display is made up of small picture elements called pixels. 

The smaller the pixels, the better the image clarity or resolution. It takes 



more than one illuminated pixel to form a whole character, such as the 

letter ‘e’ in the word help. 

 

A finite number of characters can be displayed on a screen at once. The 

screen can be divided into a series of character boxes - fixed location on 
the screen where a standard character can be placed. Most screens are 

capable of displaying 80 characters of data horizontally and 25 lines 

vertically. 

There are some disadvantages of CRT − 

 Large in Size 

 High power consumption 

Flat-Panel Display Monitor 

The flat-panel display refers to a class of video devices that have 

reduced volume, weight and power requirement in comparison to the 

CRT. You can hang them on walls or wear them on your wrists. Current 
uses of flat-panel displays include calculators, video games, monitors, 

laptop computer, and graphics display. 



 

The flat-panel display is divided into two categories − 

 Emissive Displays − Emissive displays are devices that convert 

electrical energy into light. For example, plasma panel and LED 

(Light-Emitting Diodes). 

 Non-Emissive Displays − Non-emissive displays use optical 

effects to convert sunlight or light from some other source into 

graphics patterns. For example, LCD (Liquid-Crystal Device). 

Printers 

Printer is an output device, which is used to print information on paper. 

There are two types of printers − 

 Impact Printers 

 Non-Impact Printers 

Impact Printers 

Impact printers print the characters by striking them on the ribbon, 

which is then pressed on the paper. 

Characteristics of Impact Printers are the following − 

 Very low consumable costs 

 Very noisy 

 Useful for bulk printing due to low cost 

 There is physical contact with the paper to produce an image 

These printers are of two types − 



 Character printers 

 Line printers 

Character Printers 

Character printers are the printers which print one character at a time. 

These are further divided into two types: 

 Dot Matrix Printer(DMP) 

 Daisy Wheel 

Dot Matrix Printer 

In the market, one of the most popular printers is Dot Matrix Printer. 
These printers are popular because of their ease of printing and 

economical price. Each character printed is in the form of pattern of 

dots and head consists of a Matrix of Pins of size (5*7, 7*9, 9*7 or 9*9) 
which come out to form a character which is why it is called Dot Matrix 

Printer. 

 

Advantages 

 Inexpensive 

 Widely Used 

 Other language characters can be printed 

Disadvantages 

 Slow Speed 



 Poor Quality 

Daisy Wheel 

Head is lying on a wheel and pins corresponding to characters are like 

petals of Daisy (flower) which is why it is called Daisy Wheel Printer. 
These printers are generally used for word-processing in offices that 

require a few letters to be sent here and there with very nice quality. 

 

Advantages 

 More reliable than DMP 

 Better quality 

 Fonts of character can be easily changed 

Disadvantages 

 Slower than DMP 

 Noisy 

 More expensive than DMP 

Line Printers 

Line printers are the printers which print one line at a time. 



 

 

 

 

 

Laser Printers 

 

These are non-impact page printers. They use laser lights to produce the 

dots needed to form the characters to be printed on a page. 

 

Advantages 



 Very high speed 

 Very high quality output 

 Good graphics quality 

 Supports many fonts and different character size 

Disadvantages 

 Expensive 

 Cannot be used to produce multiple copies of a document in a 
single printing 

 

Operating system 

Definition 

An operating system is a program that acts as an interface between the 
user and the computer hardware and controls the execution of all 

kinds of programs. 

 

Following are some of important functions of an operating System. 

 Memory Management 

 Processor Management 



 Device Management 

 File Management 

 Security 

 Control over system performance 

 Job accounting 

 Error detecting aids 

 Coordination between other software and users 

Memory Management 

Memory management refers to management of Primary Memory or 

Main Memory. Main memory is a large array of words or bytes where 

each word or byte has its own address. 

Main memory provides a fast storage that can be accessed directly by 

the CPU. For a program to be executed, it must in the main memory. 
An Operating System does the following activities for memory 

management − 

 Keeps tracks of primary memory, i.e., what part of it are in use by 

whom, what part are not in use. 

 In multiprogramming, the OS decides which process will get 

memory when and how much. 

 Allocates the memory when a process requests it to do so. 

 De-allocates the memory when a process no longer needs it or has 

been terminated. 

Processor Management 

In multiprogramming environment, the OS decides which process gets 
the processor when and for how much time. This function is 

called process scheduling. An Operating System does the following 

activities for processor management − 

 Keeps tracks of processor and status(0) of process. The program 

responsible for this task is known as traffic controller. 

 Allocates the processor (CPU) to a process. 

 De-allocates processor when a process is no longer required. 



Device Management 

An Operating System manages device communication via their 

respective drivers. It does the following activities for device 

management − 

 Keeps tracks of all devices. Program responsible for this task is 

known as the I/O controller. 

 Decides which process gets the device when and for how much 

time(mouse, keyboard,printer). 

 Allocates the device in the efficient way. 

 De-allocates devices. 

File Management 

A file system is normally organized into directories for easy navigation 

and usage. These directories may contain files and other directions. 

An Operating System does the following activities for file management 

− 

 Keeps track of information, location, uses, status etc. The 

collective facilities are often known as file system. 

 Decides who gets the resources. 

 Allocates the resources. 

 De-allocates the resources. 

Other Important Activities 

Following are some of the important activities that an Operating System 

performs − 

 Security − By means of password and similar other techniques, it 

prevents unauthorized access to programs and data. 

 Control over system performance − Recording delays between 

request for a service and response from the system. 

 Job accounting − Keeping track of time and resources used by 

various jobs and users. 

 Error detecting aids − Production of dumps, traces, error 

messages, and other debugging and error detecting aids. 



What is Software 

Software is a set of programs, which is designed to perform a well-

defined function. A program is a sequence of instructions written to 

solve a particular problem. 

There are two types of software − 

 System Software 

 Application Software 

System Software 

The system software is a collection of programs designed to operate, 

control, and extend the processing capabilities of the computer itself. 

System software is generally prepared by the computer manufacturers. 

These software products comprise of programs written in low-level 

languages, which interact with the hardware at a very basic level. 

System software serves as the interface between the hardware and the 

end users. 

Some examples of system software are Operating System, Compilers, 

Interpreter, Assemblers, etc. 

 

Here is a list of some of the most prominent features of a system 

software − 

 Close to the system 

 Fast in speed 

 Difficult to design 

 Difficult to understand 

  interactive 

 Smaller in size 



 Difficult to manipulate 

 Generally written in low-level language 

Application Software 

Application software products are designed to satisfy a particular need 

of a particular environment. All software applications prepared in the 

computer lab can come under the category of Application software. 

Application software may consist of a single program, such as 

Microsoft's notepad for writing and editing a simple text. It may also 

consist of a collection of programs, often called a software package, 

which work together to accomplish a task, such as a spreadsheet 

package. 

Examples of Application software are the following − 

 Payroll Software 

 Student Record Software 

 Inventory Management Software 

 Income Tax Software 

 Railways Reservation Software 

 Microsoft Office Suite Software 

 Microsoft Word 

 Microsoft Excel 

 Microsoft PowerPoint 

 

Features of application software are as follows − 

 Close to the user 

 Easy to design 

 More interactive 



 Slow in speed 

 Generally written in high-level language 

 Easy to understand 

 Easy to manipulate and use 

 Bigger in size and requires large storage space 

 

 

File Manipulation in Windows Operating system 

 

 

File organization and manipulation is an essential skill for using a 

computer. We have summarized below some of the basic operations 

that are used to perform these tasks 

1.1 Windows Explorer 

Windows Explorer is a computer program that helps you organize and 

access your data files. With this program you can create folders, copy, 

move, rename, and delete files and folders. 

 

1.2 Basic File and Folder Operations 

 

1.Creating a New Folder or Subfolder 

 

Folders are used to organize your documents. Each document you create 

should be saved in a specific folder. To create a new folder or subfolder: 

 Select the folder under which the new folder should reside. For 

example, if you want to place a subfolder within My 

Documents, go to this folder. 

 Select File from the menu bar. 

 Select New, then click on Folder. A blank folder icon will be 

created in the selected location. 



 Type the new folder name. 

 Press the Enter key. 

2.Renaming a File or Folder 

 

To rename a file or folder: 

 Select the file or folder you wish to rename. 

 Right-click on the file or folder and select Rename. Backspace or 

delete the original name and type in the new name. 

 Press the Enter key. 

3.Copying a File or Folder 

 

Files and folders can be copied from one folder to another folder or even 

from one disk drive to another drive. To copy a file from one folder to 

another folder: 

 Select the file or folder you wish to copy. 

 Select Edit from the menu bar, and then select Copy. 

 Select the new folder in which the copied file or folder should 

reside. 

 Select Edit from the menu bar, and then select Paste. The file or 

folder has been copied to the new folder. Keep in mind that the 

original file or folder remains in its original location, and a new 

copy exists in the new location. 

4 Moving a File or Folder 

Files and folders can be moved from one folder to another folder or even 

from one disk drive to another drive. To move a file from one folder to 

another folder: 

 Select the file or folder you wish to move. 

 Select Edit from the menu bar, and then select Cut. 

 Select the new folder in which the moved file or folder should 

reside. 



 Select Edit from the menu bar, and then select Paste. The file or 

folder has been moved to the new folder. 

5.Deleting a File or Folder 

To delete a file or folder: 

 Select the file or folder you wish to delete. 

 Right-click on the file and select Delete. 

 A Confirm File (or Folder) Delete box will be displayed. Click 

on yes . 

 Note: When you delete a folder, all files and subfolders in the 

folder are also deleted. 
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What is Microsoft Word used for? 

Microsoft Word allows you to create professional-quality documents, 
reports, letters, and résumés. Unlike a plain text editor, Microsoft Word 

has features including spell check, grammar check, text 

and font formatting.extension name of word file is .docx.. 

 

 

 

 

 

 



 

Microsoft word features  

1. Working With Text and Styles 

Microsoft Word is a word processor, which means that it's designed 
primarily for text-based documents. In Word, you type text and see 

roughly how it will appear on someone else's computer screen or on 

paper. You can change the font, color, size and other style settings for 

text using Word's built-in options.  

2. Saving and Printing 

After you create a document in Word, you usually want to save it for 

later access, send to someone, print it out, or any combination of these 

uses. With Word, you can save a document in a variety of formats for 

compatibility with other software.  

3.Word and Compatibility 

Microsoft Word has been designed for years to maximize compatibility 

between versions. Typically, versions of Microsoft Word can open files 

created in previous versions of the software and save files in formats 

usable by earlier versions. You can also save files in formats such as 

Rich Text Format, which is used by a variety of competing products. 

4.Cloud and Local Support 

Microsoft Word offers a local version of the software that you can 

access on your computer and a version you can access through your 
web browser. In the past, Word was only available as a program you 

install locally on your computer. 

5.Built-in Collaboration 

Modern versions of Microsoft Word allow multiple people to edit the 

same document. This is an improvement on previous editions and some 
competing products, which require people to edit documents one at a 



time and email or otherwise share changed versions for review and 

further editing.  

6.Microsoft Word Formatting Features 

A substantial number of parts of Microsoft Word are designed around 

formatting text. You can choose from a wide variety of fonts and colors 

for text in a document, create formatted sections such as tables with 

bulleted or numbered lists and entries, and insert images  

7.Saving, Loading and Printing 

Like other modern word processing programs, Microsoft Word enables 

you to save files so that you can reopen them later. You can save your 

documents in a variety of formats to ensure compatibility with older 

versions of Word or with other word processing tools. 

8.Save and Save As: 

This is possibly the first command you should use when you type some 

text. It enables you to save your document on the hard disk as a .docx 

file (by default). Take note of the type of file here.  

9.Templates: – In MS Word are pre-defined professional designs for 
users. In which all the page layout, fonts, colors, graphics, outline, text 

boxes, etc. word processor user get by default. To insert template you 

need to go File Menu -> New then you can see available templates and 

office.com template. 

10.Clipboard: – In Microsoft Word Home Menu Clipboard is the first 

category menu that is used to store copied material temporarily.  Such 

as text and picture or any object in Microsoft Word.  

 

 

  

 



Word Options 

1.File tab. From then menu on the left, select Options. (Rather 

confusingly it looks like the Info tab is selected.  

 

 

   

 

2. Home Tab 

It have Font, Font Size, Bold , Italic , Font Color options . 

3.Insert Tab 

This tab contains all the commands for inserting items into your 

documents such as Cover Page, Tables, Header & Footer etc.  

 



 

Tables 

When a table is selected you will see additional contextual tabs Tables > Table Tools Design 

 

 

Illustrations 

 

 

4.Mail merge 

This tab contains everything needed to complete a successful mail merge. 

Create 

 

Envelopes - Lets you create and print envelopes. 

Labels - Lets you create and print labels. 

https://bettersolutions.com/word/tables/table-tools-design-tab.htm


 

 

Start Mail Merge 

 

Start Mail Merge - Drop-Down. The drop-down contains the commands: Letters, E-mail 

Messages, Envelopes, Labels, Directory, Normal Word Document and Step-by-Step Mail 

Merge Wizard. Creates a from letter which you intend to email or print multiple times sending 

each copy to a different recipient. Displays the "New Address List" dialog box. 

Select Recipients - Drop-Down. The 3 options are from step 3 of the wizard. The drop-down 

contains the commands: Type New List, Use Existing List and Select from Outlook Contacts. 

Type New List displays the "New Address List" dialog box. You will have to save this list as a 

Microsoft Office Address List (.mdb). 

Edit Recipient List - Displays the "Mail Merge Recipients" dialog box allowing you to change 

or filter the list of recipients. 

 

 

Write & Insert Fields 

These commands are only available when you are in a mail merge document. 

 

Highlight Merge Fields - Highlights all the fields in the active document that have been 

inserted. This makes is easy to see what will be replaced. 

Address Block - Displays the "Insert Address Block" dialog box. This allows you to customise 

how the address will be inserted. 

Greeting Line - Displays the "Insert Greeting Line" dialog box. Lets you add a greeting line to 

your document. 

Insert Merge Field - Button with Drop-Down. The button displays the "Insert Merge Field" 

dialog box. The drop-down allows you to quickly insert a merge field just by clicking on it in 

the list and contains the commands: Title, First_Name, Last_Name, Company_Name, 

Address_Line_a, Address_Line_2, City, State, Zip_Code, Country_or_Region, Home_Phone, 

Work_Phone, Email_Address. 



Rules - Drop-Down. Lets you add decision making rules to the mail merge. The drop-down 

contains the commands: Ask, Fill-in, If-Then-Else, Merge Record, Merge Sequence, Next 

Record, Next Record If, Set Bookmark, Skip Record If. 

Match Fields - Displays the "Match Fields" dialog box allowing you to match the required 

fields with the recipients list. 

Update Labels - Only enabled when creating labels. Updates all the labels in the document to 

be consistent with the first label. 

 

5.Image Size and Quality 

Apply image size and quality settings for an open document or for all new documents. 

6.Chart 

Allow custom formatting and labels to stay with data points, even if the chart changes. 

7.Show document content 

Choose formatting, text, and image options. 

8.Display 

Choose a measurement format, show scrolling bars, and select the number of documents shown 

in the Recent Documents list. 

9.Print 

Optimize the appearance of the hard-copy version of the document or change your printer paper 

size. 

10.Save 

Save backup copies, automatically save changes to templates, or allow backup saves. 

 

 

 

 

 

 

 



 

 

PowerPoint  

PowerPoint is a complete presentation graphics package. It gives you everything you 

need to produce a professional-looking presentation. PowerPoint offers word 

processing, outlining, drawing, graphing, and presentation management tools- all 

designed to be easy to use and learn. 

Features of PowerPoint 

1) Adding Smart Art 

 

Don’t confuse SmartArt with the similarly named WordArt. Where WordArt just 

allows you to display text using a wide variety of different formats and effects, 



SmartArt is a comprehensive and flexible business diagram tool that greatly 

improves upon the ‘Diagram Gallery’ feature found in previous versions of Office. 

Click the insert SmartChart Graphic to choose from a selection of options. 

SmartArt can be used to create professional diagrams that include pictures and 

text or combinations of the two. An obvious use of SmartArt would be to create 

an organisation chart but it can be used for many different kinds of diagrams and 

even to provide some variety to slides using text bullet points. 

  

2) Inserting Shapes 

 



If you need to include some sort of diagram in your presentation, then the quickest 

and easiest way is probably to use SmartArt. However, it is important to be able to 

include shapes independently of SmartArt and worth being familiar with the 

various Drawing Tool format options. 

Not only will they be useful if you do need to manually draw a diagram (and 

SmartArt doesn’t suit all diagrams), but they can also be applied to objects on a 

slide that you might not immediately think of as shapes. For example the box that 

contains your slide title or your content. This can be anything from text to a video, 

or even the individual shapes in a SmartArt diagram. 

As you can see, the gallery of available shapes is very extensive. Once you have 

selected your chosen shape, you can just click in your slide to insert a default 

version of the shape or, to set a particular size and position, click and drag with 

the mouse to create the shape and size you want.  

  

3) Inserting an Image  



 

Here are two content type icons which appear in new content Placeholders for 

inserting pictures. You can Insert Picture from File or Insert Clip Art. 

Alternatively, the Illustrations group of the Insert ribbon tab includes the same 

two tools. In addition, PowerPoint 2010 has a new ‘Screenshot’ option that allows 

you to capture an entire window or part of a window for inclusion on a slide. You 

can also copy any image and just paste it directly to a slide. 

Insert Picture from File allows you to browse to an image file saved somewhere 

on your system whereas Clip Art is held in an indexed gallery of different media 

types. Clip Art is not limited to pictures: ‘The Results should be:’ box lets you 

choose between: ‘All media file types’ and one or more of the following different 

types: 

 Illustrations 

 Photographs 

 Video 

 Audio 

https://learn.filtered.com/microsoft-powerpoint


Once you have found the image you want to use, click on it to insert it into the 

current slide. You can now re-size and move the image accordingly with further 

editting options available when you right click the desired image. 

  

4) Slide Transitions 

 

Properly used, slide transitions can be make your presentations clearer and more 

interesting and, where appropriate, more fun. Badly used, the effect of slide 

transitions can be closer to irritating or even nauseating. Simple animation effects 

are often used to add interest to bullet point text. Much more extreme animation 

effects are available but, in most cases, should be used sparingly if at all. 

Two main kinds of animation are available in a PowerPoint presentation: the 

transition from one slide to the next and the animation of images/text on a 

specific slide.  

In PowerPoint 2010 & 2013 there is also a separate Transitions ribbon tab that 

includes a gallery of different transition effects. These can be applied to selected 

slides or all slides. If you want to apply different transition effects to different 

groups of slides, then you might want to choose ‘Slide Sorter’ view from the 

Presentation Views group of the View ribbon. 

  

5) Adding Animations 



 

Whereas the transition effects are limited to a single event per slide, animations 

can be applied to every object on a slide – including titles and other text boxes. 

Many objects can even have animation applied to different components, for 

example each shape in a SmartArt graphic, each paragraph in a text box and each 

column in a chart. Animations can be applied to three separate ‘events’ for each 

object: 

Entrance – how the object arrives on the slide 

Emphasis – an effect to focus attention on an object while it is visible 

Exit – how the object disappears from the slide 

To apply an animation effect, choose the object or objects to be animated, then 

choose Animation Styles or Add Animation from the Animations toolbar. 

 

PPT Options  

1.Editing options 



When selecting, automatically select entire word     Select this check box to select 

the entire word when you click a word, or clear this check box to select an 

individual letter in a word when you click a word. 

2.Cut, copy, and paste 

Use smart cut and paste     Select this check box if you want PowerPoint to 

adjust the spacing of words and objects that you paste into your presentation. 

Smart cut and paste ensures that pasted content does not run up against other 

words or objects that appear before or after the content that you paste.  

3.Image size and quality 

Options that you set in this section are only applicable to the presentation file that 

you have open at the time. 

4.Chart options 

Properties follow chart data point for all new presentations     Select this 

check box to have custom formatting and chart data labels follow data points as 

they move or change in the chart. This setting applies to all presentations created 

hereafter. 

5.Display 

Show this number of recent documents/presentations     Enter the number of 

recently opened or edited presentations that you want to appear in the Recent 

Documents list. 

6.Show shortcut keys in ScreenTips  

    Select this check box to show the keyboard shortcuts in all ScreenTips, or clear 

this check box to hide the keyboard shortcuts in all ScreenTips. 

7.Automatically extend display when presenting on a laptop or tablet     

 (PowerPoint 2013 and newer versions) To turn off using presenter view, clear 

this check box. By default, PowerPoint uses presenter view for slide shows.  

8.Open all documents using this view      

Select an option from the list to specify that all presentations open in a 

specific view each time that you start PowerPoint. 

 

https://support.microsoft.com/en-us/office/show-or-hide-screentips-72d92d6a-6d2a-40fd-9ac2-fb9413ffce18


9.Slide Show 

Show menu on right mouse click     Select this check box to show a shortcut 

menu when you right-click a slide in Slide Show view, or clear this check box to 

prevent the shortcut menu from showing. 

10.Print 

Print in background     Select this check box to work in PowerPoint while you print your 

presentation (printing can slow the response time in PowerPoint), or clear this check box to turn 

off background printing when you want rapid response time while you work in PowerPoint. 

 

 

 

 

 

 

 

 

 

 

 

 

Unit-III 
 

 

 

https://support.microsoft.com/en-us/office/choose-the-right-view-for-the-task-in-powerpoint-21332d8d-adbc-4717-a2c6-e25a697b40e9


 

 

 

 

 

 

 

 

 

 

 

 

 

 

Microsoft Excel 

Workbooks/Sheets 

A workbook is the name given to an Excel document and has the file extension (".xlsx"). 

A workbook contains one or more worksheets and there are 3 worksheets in the default 

workbook. 

There are tabs at the bottom of the workbook to enable you to select which worksheet is 

currently displayed. 



 

Features of Microsoft Excel 

1. Add Header and Footer 

MS Excel allows us to keep the header and footer in our spreadsheet document. 

2. Find and Replace Command 

MS Excel allows us to find the needed data (text and numbers) in the workbook and also 

replace the existing data with a new one. 

3. Password Protection 

It allows the user to protect their workbooks by using a password from unauthorized access to 

their information. 

4. Data Filtering 

Filtering is a quick and easy way to find and work with a subset of data in a range. A filtered 

range displays only the rows that meet the criteria you specify for a column. MS Excel provides 

two commands for filtering ranges: 

           • AutoFilter; which includes filter by selection, for simple criteria 

           • Advanced Filter; for more complex criteria 

5. Data Sorting 

Data sorting is the process of arranging data in some logical order. MS Excel allows us to sort 

data either in ascending or descending order. 



6. Built-in formulae 

MS Excel has got many built-in formulae for sum, average, minimum, etc. We can use those 

formulae as per our needs. 

7. Create different charts (Pivot Table Report) 

MS Excel allows us to create different charts such as bar graph, pie- charts, line graphs, 

etc. This helps us to analyze and compare data very easily. 

8. Automatically edits the result 

MS Excel automatically edits the result if any changes are made in any of the cells. 

9. Formula Auditing 

Using formula auditing we can graphically display or trace the relationships between cells and 

formulas with blue arrows.  

 

 

 

 

Excel Components   

1.The outside window is the Title Bar or Application Window. 

This window displays the name of the application and the name of the active 

workbook. 

Minimise - Excel is reduced to a button on the taskbar. 

Restore - Restores the application window to its original size before it was 

maximised or minimised. 

or Maximise - Increases the size of the Excel window to fill the whole screen. 

Close - Closes Excel completely. 

 

2.The inside window is the Menu Bar or Workbook Window. 

 

 



 

Creating 

When you start Excel an empty workbook is automatically opened for you. 

You can easily create a new workbook by selecting (File > New) and clicking on 

Blank workbook in the New Workbook task pane. 

You can also use the shortcut key (Ctrl + N). 

Deleting 

There are several ways you can delete unwanted workbooks. 

Probably the easiest way is to open Windows Explorer, browse to the folder, 

select the file and press Delete. 

You can also delete workbooks from the (File > Open) and (File > Save As) 

dialog boxes. 

Just select the workbook and either use the Delete button on the top or select the 

file and use the shortcut menu. 

Opening 

You can open a workbook by selecting (File > Open) or by using the shortcut key (Ctrl + O). 

Alternatively you can use the button on the Standard toolbar. 

 

Open - Displays the (File > Open) dialog box. 

When you display the (File > Open) dialog box, a default folder location is used. This can be 

changed from (Tools > Options)(General tab, Default File Location). 

If you save all your workbooks in the same folder it is definitely worth changing your default 

folder. 

You can also double click an Excel file from within Windows Explorer. Excel files have the file 

extension (".xls"). If Excel is not currently open then it will open automatically.  

You can also open a file using the Recently Used Menu. This is located at the bottom of your 

File menu (see below). 



 

By default your last 4 Excel workbooks that have been opened using the (File > Open) dialog 

box will be listed here. You can select one of these to quickly re-open the workbook. 

You can change the number of files listed here by selecting (Tools > Options)(General 

tab, Recently used file list). This can be a number between 1 and 9. 

If you attempt to open an Excel workbook that is already open you will be asked if you want to 

open a read-only copy. 

 

 

Dialog Box 



 

It is possible to open more than one file by holding down the Ctrl key and selecting the files 

with your mouse. 

Look in - Displays the folder where the workbook will be saved. To change to a different disk 

drive or folder, open the Look in drop-down list and click the letter of the disk drive or name of 

the folder. F4 or (Alt + I). Pressing F5 will refresh the list of files. 

File name - The name of the file you want to open. 

Files of type - Provides a list of all the different formats you can open using Excel. The default 

is "All Microsoft Excel files". You can find a list of all the File Extensions page. 

Open - Opens the workbook that is currently selected. 

Cancel - Closes the dialog box. 

Closing 

Closing your workbooks when you have finished with them can be done in several ways. 

The easiest way is to select (File > Close) or by using the shortcut key (Ctrl + W). 

You can also close the active workbook by clicking on the icon on the left of the Menu Bar. 

https://bettersolutions.com/excel/workbooks/file-extensions.htm


 

An alternative way to close the active workbook is to press the black cross on the control menu 

in the top right hand corner of the Menu Bar. 

 

 

Formatting 

Applying formatting to your worksheets will make them easier to read and 

interpret your data. 

You can apply formatting to cells very quickly by selecting the cells or range of 

cells and choosing the appropriate commands. 

Formatting toolbar 

Allows you to alter the appearance and alignment of the data on a worksheet. 

 

  Number: - We use this option to change the number formatting into General, 

Percentage, Currency, Date, Time, Fraction etc. We can increase and decrease the 

decimal and convert the number into accounting number. 

 

 

 

https://www.exceltip.com/wp-content/uploads/2015/07/image-65.png
https://www.exceltip.com/wp-content/uploads/2015/07/image-65.png


 Function Library: -In Excel, we have 461 functions and they are available in the 

formulas tab under the function library group. And there is no need to learn every 

formula for we can find formulas category wise such as:- Financial, Logical, Text, 

Date & Time, Lookup & Reference, Math & Trig, many more. 

 

 

 

   Macros: -With this option, we can record the macro and then we can view the 

macro. 

 

 

File  

In this tab, we can use the object relate options such as we can change the fill 

color, outline color, outline width, shape style, and we can insert more objects, 

even. 

 

Insert  

If we insert the chart, then 2 contextual tabs will be activated: - 1st Design and 

2nd Format. 

https://www.exceltip.com/wp-content/uploads/2015/08/image-71.png


 

 

Format Tab: - We use this tab to format the chart as an object. In order to insert 

the new shape, we can change chart’s shape-style, Fill-color, Shape-outline, 

shape-effects, etc. 

 

 

 

 

Types of Formulas in Excel 

1.Automatic Functions  

 Sum= This Function is Used to find sum of given data 

 Average = This Function is Used to find average  of given data 

 Count= This Function is Used to find total of given data 

 Min= This Function is Used to find minimum value of given data 

 Max=This Function is Used to find Maximum of given data 



 

 

2. Maunal Formulas  

Create a formula that refers to values in other cells 

1. Select a cell. 

2. Type the equal sign =. 

Note: Formulas in Excel always begin with the equal sign. 

3. Select a cell or type its address in the selected cell. 

 

4. Enter an operator. For example, – for subtraction. 

5. Select the next cell, or type its address in the selected cell. 



 

6. Press Enter. The result of the calculation appears in the cell with the formula. 

See a formula 

1. When a formula is entered into a cell, it also appears in the Formula bar. 

 

2. To see a formula, select a cell, and it will appear in the formula bar. 

 

Enter a formula that contains a built-in function 

1. Select an empty cell. 

2. Type an equal sign = and then type a function. For example, =SUM for 

getting the total sales. 

3. Type an opening parenthesis (. 

4. Select the range of cells, and then type a closing parenthesis). 

 

5. Press Enter to get the result. 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

Unit-IV 
 

 

 



 

 

 

 

 

 

 

 

 

 

 

E-Commerce 

 

Meaning 

Ecommerce, also known as electronic commerce or internet commerce, 

refers to the buying and selling of goods or services using the internet, 
and the transfer of money and data to execute these transactions. 

Ecommerce is often used to refer to the sale of physical products online, 

but it can also describe any kind of commercial transaction that is 

facilitated through the internet. 

 

 

E-commerce vs Traditional commerce Comparison Table 

Let’s look at the top Comparison between E-commerce vs Traditional 

commerce – 

 

 



The basis of 

comparison 

Between E-

commerce vs 

Traditional 

commerce 

E-commerce Traditional commerce 

Definition E-Commerce is a form of online 

shopping where users can buy 

goods and services from their 
electronic devices such as a 

laptop, mobile, tablet. 

Traditional-Commerce is a 

traditional approach to buy goods 

and services in person which 
involves face to face dealing. 

Usage It is used to save valuable time 
and money. 

It is ancient and still in usage where 
the digital network is not reachable. 

Process It is easier to use and operate if 
the customer has basic digital 

gadget knowledge. 

It can be followed by any person 
irrespective of education or 

knowledge. 

Mode It is in electronic or digital mode 
only 

It can be in any form which is non-
electronic or manual form. 

Time It is available round the clock It is available during the limited 

time as prescribed by the law and 
based on the type of business. 

Purchase Inspecting a product before 
purchasing is not possible in this 

type. 

Inspecting a product before 
purchasing is possible in a 

traditional commerce business 

model. 

Involvement It involves only digital gadget 

engagement to place the order 

It involves face to face involvement 

of both buyer and seller 

Business More business can be done 
easily without any hassles 

It is difficult to perform more 
business in this model 

Maintenance Easier to maintain this as the 
only warehouse is enough to 

It is cost effective as display and 
showcase of the products are 



 

 

Features of E-commerce   

 

1. User-Friendly 

Simplicity should be a goal in good design and you don’t have to 

sacrifice elegance to achieve it. 

As a matter of fact, studies show that 76% of consumers say the most 

important characteristic of a website is ease of use. 

2. Mobile-Friendly Website 

Mobile shopping accounts for 50% of online transactions. 

With a responsive website, content intuitively adapts to whatever device 

is accessing it to provide the most user-friendly experience. 

Walmart increased mobile sales by 98% after optimizing its mobile 

site. 

3. High-Resolution Photos & Video 

Gone are the days of posting one photo with a few bullet points and a 

price tag. 

Shoppers want to see multiple angles and people using the product in 
different environments. They want to be able to zoom in and get a feel 

for the product. 

Technical considerations for images are crucial. Images that don’t load 

or take too long to load will see a consumer drop-off rate of 39%, 

according to Adobe 

 

store the goods. required to attract the customers. 

https://blog.hubspot.com/blog/tabid/6307/bid/14953/What-Do-76-of-Consumers-Want-From-Your-Website-New-Data.aspx
https://www.criteo.com/news/press-releases/2018/09/criteos-q2-2018-global-commerce-review-points-to-continued-worldwide-growth-of-in-app-transactions/
https://bluestout.com/blog/mobile-ecommerce-site-design-case-study/
https://blogs.adobe.com/creative/files/2015/12/Adobe-State-of-Content-Report.pdf


4. User-Generated Reviews 

Shoppers read reviews. About 95% of them, in fact. 

And 57% of consumers will only use a business if it has 4 or more stars. 

You might think that having negative reviews is a sale killer. The 

opposite is actually true. 

Having negative reviews can often be positive. It’s shown that products 

without negative reviews are seen as censored and, in turn, shoppers 

will assume the positive reviews are fake. 

5. Special Offers 

Most ecommerce sites are using special offers in their standard 

marketing practices via email, social, text, etc. 

6. Wish Lists 

Oh, how I love wish lists. One for fashion, one for books to read, one 

for holiday gift ideas. 

7. Related Items 

Simply seeing the phrase, “you might like this” causes a serotonin 

release signaling curiosity and excitement. 

A ‘Related Items’ feature on an ecommerce site creates the desirable 

stickiness effect that so many marketers strive to achieve. 

8. Frequently Asked Questions (FAQ) 

Complex purchases require confidence with a seller and detailed 

information when buying products online versus face-to-face. 

Fine Watch Bank (disclosure: they were a client) sells expertly crafted 

high-end watches. 

https://www.brightlocal.com/learn/local-consumer-review-survey/


The company’s buyers need confirmation of watch authenticity and 
detailed product information to feel comfortable when making a 

purchase. 

9. Security Features 

Online transactions are an integral part of our lives. 

As such, ecommerce websites can be a lucrative target for 

cybercriminals. It’s crucial that online sellers protect customer 

information and take steps to ensure privacy. 

Challenges/Limitations  of E-commerce  

1. Cyber security:  Businesses that focus their attention in the e-

commerce space need policies and procedures to create a solid 

cybersecurity framework for the organization. In the case of a 
cyberattack, a small business cannot afford to have downtime in 

operations and sales. 

2. Competition 

Competition comes in many forms for small businesses, especially in 

the e-commerce space. You have to keep up with competitive pricing, 

products and service.  

3. Order fulfillment 

Not everything has to fall on the back of the small business owner. You 

could be inundated with more orders than you are prepared to handle on 

your own.  

4. Customer experience 

As a primarily e-commerce business, or a business that has an e-
commerce site as a secondary means of selling its products, figuring out 

how to offer your customers the same experience they would get in a 

brick-and-mortar store can be challenging.  

 



5. Visibility 

How are you supposed to get quality traffic to your site and turn 
visitors into customers if people can't find your site to begin with? It's a 

big issue for e-commerce businesses, and one that could make or break 

a business.  

6. Return/refund policy 

Having a good return/refund policy could be the difference between 

success and failure. That sounds extreme, but it's true.  

"If you want your brand to stand tall, then customer satisfaction should 

be the first priority, and whatever you're selling should be the same as 

what's advertised 

7. Finding the right market 

"The first step of any business is to find product/market fit, and e-
commerce is no different," said Rubright. "Product-market fit is the 

degree to which a product satisfies market demand. The easiest way to 

find that fit quickly is to build a product that solves a problem you 

have."  

8. Technical Issues 

Running an e-commerce store makes you reliant on both soft- and 

hardware. In addition to actions that can be planned, such as 

migrations and upgrades, you may face sudden server issues, 

problems with security, various downtimes and more. 

9. Shipping Issues 

Shipping is one of the biggest headaches for every e-commerce 

business owner. In contrast to traditional retail where the customer 
contacts the seller directly, e-commerce means you need to arrange the 

shipment of products.  

 

 



What is Website ? 

A website (also written as web site) is a collection of web pages and 
related content that is identified by a common domain name and 

published on at least one web server. Notable examples 

are wikipedia.org, google.com, and amazon.com,www.ptu.ac.in. 

 

Website Components  

1. Reliable Web Hosting Service 

Think of your web host as similar to a landlord who rents you space 

for a physical store. They provide and maintain the server space where 
your site files “live” and make it possible for visitors to come by and 

explore your site. 

2. A Content Management System (CMS) 

Your content management system works behind the scenes to help you 

organize and maintain parts of your website like your site pages 

and meta data, and it makes it easier for visitors to find their way 

around your site. 

3. SEO Basics 

Optimizing your site so it appears in search engines is a must. With 

millions of sites on the internet now in competition for a spot on the 1st 
page of search results, you’ll need to follow a few search engine 

optimization (SEO) best practices to get found. 

 

4. Analytics Tools 

You’ll want to know how people are finding your site, which pages 
they spend the most time on, and how well different elements of your 

site convert. Google Analytics is the most popular and easy to use 

resource, it doesn’t cost anything, and it integrates easily with 

WordPress and some website builder tools. 



5. Inventory Management 

When you’re selling products on your site, you’ll want to make sure 
you keep track of what you have in stock, what’s sold, and what’s on 

order. 

6. Sections That Visitors Expect 

A home page that lets you know what the site’s for, an about 

us section that shows there are real people behind the site, and contact 
information so readers or customers can reach you if they have 

questions or feedback. 

7. Media 

It’s a rare site that can build an audience on words alone. Our eyes are 

naturally drawn to images, especially if they move and make noise, and 
images are a must if you’re selling merchandise online. People will also 

want to see a photo of you in your about us section. 

8. Shopping Cart and Payment Tools 

If your site includes a shop, you’ll want a reliable, easy to use shopping 

cart and payment tools like PayPal or Square that are popular with most 

online shoppers. 

9. Search engine   

A search engine is a website through which users can search internet 

content. To do this, users enter the desired search term into 

the search field. The search engine then looks through its index for 

relevant websites and displays them in the form of a list. 

 

 



 

Internet in advertising media  

 

Digital marketing is the component of marketing that utilizes internet 

and online based digital technologies such as desktop computers, mobile 

phones and other digital media and platforms to promote products and 

services. 

 

Features /Advantages  
 

Cost 

The low costs of electronic communication reduce the cost of displaying 
online advertisements compared to offline ads. Online advertising, and 

in particular social media, provides a low-cost means for advertisers to 

engage with large established communities.Advertising online offers 
better returns than in other media. 

 

Measurability 

Online advertisers can collect data on their ads' effectiveness, such as 

the size of the potential audience or actual audience response, how a 

visitor reached their advertisement, whether the advertisement resulted 
in a sale, and whether an ad actually loaded within a visitor's view. This 

helps online advertisers improve their ad campaigns over time. 

 

Formatting 

Advertisers have a wide variety of ways of presenting their promotional 

messages, including the ability to convey images, video, audio, and 

links. Unlike many offline ads, online ads also can be interactive. For 

example, some ads let users input queries or let users follow the 

advertiser on social media.Online ads can even incorporate games. 
 

Targeting 

Publishers can offer advertisers the ability to reach customizable and 

narrow market segments for targeted advertising. Online advertising 

may use geo-targeting to display relevant advertisements to the user's 

geography. Advertisers can customize each individual ad to a 



particular user based on the user's previous preferences.Advertisers can 
also track whether a visitor has already seen a particular ad in order to 

reduce unwanted repetitious exposures and provide adequate time gaps 

between exposures. 
 

Coverage 

Online advertising can reach nearly every global market, and online 

advertising influences offline sales. 

Speed 

Once ad design is complete, online ads can be deployed immediately. 
The delivery of online ads does not need to be linked to the publisher's 

publication schedule.  

Engage Your Customers 

The Internet is the best platform to keep your target audience engaged. 

Do thorough research on your target audience and find out what type of 

products and services they are looking for and what they think about 

your products. Plan your ad campaigns accordingly. 

Access to Data 

With the help of online analytics tools, you can decipher which 

strategies are working for you and which are not. You can analyze 

customer data such as keyword data and can further make the required 
changes.  

 

Fast and Easy 

Unlike traditional marketing and advertising methods, online advertising is 

fast and easy. Traditional advertising procedure is too long and 
consumes much time.  

https://www.redalkemi.com/blog/post/significance-of-keyword-research-tools-for-your-business
https://www.redalkemi.com/blog/post/traditional-marketing-vs-social-media-marketing


 

 

 

The Web as a Sales Channel 

The Internet also gives retailers an additional channel to sell products. 

Thirty years ago, a retail store without a physical storefront was all but 
unheard of. Today, you can buy almost anything you want on the 

Internet by visiting a company's website. This lets you sell more 

products without the cost of having to rent out and stock additional 

retail floor space. 

 

 

Electronic Payment Services 

An E-commerce payment system (or an electronic payment system) 
facilitates the acceptance of electronic payment for online transactions. 

Also known as a subcomponent of electronic data interchange (EDI), e-

commerce payment systems have become increasingly popular due to 

the widespread use of the internet-based shopping and banking. 

 

Listed below are some of the modes of electronic payments – 

 

Credit Card 

Debit Card 

Smart Card 

E-Money 

Electronic Fund Transfer (EFT) 



Paytm 

UPI 

 

 

 

Credit Card 

Payment using credit card is one of most common mode of electronic 
payment. Credit card is small plastic card with a unique number 

attached with an account. It has also a magnetic strip embedded in it 

which is used to read credit card via card readers. When a customer 

purchases a product via credit card. 

 Debit card 

Debit card, like credit card, is a small plastic card with a unique 

number mapped with the bank account number. It is required to have a 

bank account before getting a debit card from the bank. The major 
difference between a debit card and a credit card is that in case of 

payment through debit card, the amount gets deducted from the card’s 

bank account immediately and there should be sufficient balance in the 
bank account for the transaction to get completed; whereas in case of a 

credit card transaction, there is no such compulsion. 

 

Smart Card 

Smart card is again similar to a credit card or a debit card in appearance, 

but it has a small microprocessor chip embedded in it. It has the 
capacity to store a customer’s work-related and/or personal information. 

Smart cards are also used to store money and the amount gets deducted 

after every transaction. 

 



 

 

E-Money 

E-Money transactions refer to situation where payment is done over the 
network and the amount gets transferred from one financial body to 

another financial body without any involvement of a middleman. E-

money transactions are faster, convenient, and saves a lot of time. 

 

Electronic Fund Transfer 

It is a very popular electronic payment method to transfer money from 
one bank account to another bank account. Accounts can be in the same 

bank or different banks. Fund transfer can be done using ATM 

(Automated Teller Machine) or using a computer. 

Nowadays, internet-based EFT is getting popular. In this case, a 
customer uses the website provided by the bank, logs in to the bank’s 

website and registers another bank account. 

Paytm 

Paytm is India’s largest mobile payments and commerce platform. We 

help you transfer money instantly to anyone at zero cost using the 
Paytm Wallet. This money can then be used to pay seamlessly at 

several places like taxi and autos, petrol pumps, grocery shops, 

restaurants, coffee shops, multiplexes. 

UPI 

Unified Payments Interface (UPI) is an instant real-time payment 
system developed by National Payments Corporation of India 

facilitating inter-bank transactions. The interface is regulated by the 
Reserve Bank of India and works by instantly transferring funds 

between two bank accounts on a mobile platform.  

Google Checkout 



 

Google Checkout is Google’s answer to PayPal. Google Checkout 
allows users to pay for goods and services through an account 

connected to their Google profile. The major benefit that Google 

Checkout has over the competition is that millions of Internet users use 
Google for other services, making a purchase through Checkout a 

simpler process. 

 

Paypal 

PayPal is the world’s most widely used payment acquirer, processing 

over $4 billion in payments in 2011. PayPal payments are made using a 

user’s existing account or with a credit card. Money can be sent directly 

to an email address. 

 

Authorize .net 

Authorize.Net is the Internet’s most widely used payment gateway. With 

a user base of over 300,000 merchants, Authorize.Net has been the go-to 

method for e-commerce sites that need a gateway to accepting payments.  

 

Security Issues of Online Payment 

 

 

Security is an essential part of any transaction that takes place over the 

internet. Customers will lose his/her faith in e-business if its security is 

compromised. Following are the essential requirements for safe e-

payments/transactions – 

 

Confidentiality – Information should not be accessible to an 

unauthorized person. It should not be intercepted during the transmission. 



 

Integrity – Information should not be altered during its transmission 

over the network. 

 

Availability – Information should be available wherever and whenever 

required within a time limit specified. 

 

Authenticity – There should be a mechanism to authenticate a user 

before giving him/her an access to the required information. 

 

Non-Repudiability – It is the protection against the denial of order or 

denial of payment. Once a sender sends a message, the sender should not 

be able to deny sending the message. Similarly, the recipient of message 

should not be able to deny the receipt. 

 

Encryption – Information should be encrypted and decrypted only by 

an authorized user. 

 

Auditability – Data should be recorded in such a way that it can be 

audited for integrity requirements. 

 

 

Credit Card Fraud 

Credit card fraud is the most common security threat that online retailers 

face. It occurs when a hacker gains unauthorized access to customers’ 

personal and payment information. To access this data, the hacker may 

penetrate the database of an e-commerce site using malicious software 

programs. At times, a hacker’s intention when stealing customers’ data 

is to sell it on black markets. 



  

Distributed Denial of Service (DDoS) Attacks 

This type of security threat aims at taking down an online retail store by 

sending overwhelming requests to its servers. The attacks originate from 

thousands of untraceable IP addresses. When this type of threat hits the 

servers, they slow down or completely shut down. An e-commerce site 

can also go offline temporarily when a DDoS attack affects its servers. 

 

Man-in-the-middle Attacks 

As hackers are becoming smarter with technology, they are devising 

ways of listening to the communications made by users of an e-

commerce website. Through an approach known as a man-in-the-middle 

attack, these hackers maliciously trick users into connecting to a public 

wireless network. They gain access to people’s devices once they are on 

public wireless networks. Hackers get to see a people’s browsing history, 

credit card numbers, passwords and usernames if the websites they are 

visiting lack strong encryptions. 

 

Bad Bots 

Bots, either good or bad, are all over the worldwide web. Search engines 

such as Bing and Google use good bots for indexing search results. On 

the other hand, there are hackers that use malicious bots for gathering 

data such as product data, inventories and pricing data. These bots are 

also capable of accessing the database of an e-commerce site and listing 

the logins of user accounts. 

 

Malware 

In information technology, malware simply refers to malicious software 

programs. Attackers usually inject web pages or files with these 

malicious programs to help them in gaining access to online retails 



stores. Through means such as SQL injection, they can easily insert the 

malware into a website’s database allowing it to compromise the data 

stored in the database. 

 

Phishing Scams 

E-commerce sites are also prone to phishing scams sent by known or 

unknown people in form of emails. These scams focus on targeting 

important user data like credit card numbers and login credentials. An 

attacker may use a scheme known as social engineering to lure online 

shoppers to give out their personal information.  

 

 

 

https://bettersolutions.com/word/ribbon/insert-tab.htm 
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